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1. Introduction

This help file covers how to run the desktop version of the FBS main program including how to run 
network games.  When you first run the main program, it will prompt you for a new scenario to 
load.  If you want to load an existing battle file, then cancel this dialog and open the battle file using
the Open option of the File menu.  At any time, you can start a new scenario in the main program 
by using the New option.

2. The Main Program Interface

The interface of the Main Program consists of various parts:

• Main Chart – In the middle of the main program window, the Main Chart is displayed.  It 
consists of a number of hexes, each one a size determined by the specific scenario.  In each 
hex, you have a number of counters.  Each counter represents a group of units of a given 
type such as seacraft, aircraft, etc.

• Unit List – On the left-hand side of the main program window, the Unit List is displayed. 
When you click on a hex in the Main Chart, the hex becomes the Hot Spot and the Unit List
will display the units in that hex. You can click on units in the Unit List to select or unselect 
them for various functions you perform in the Main Program.

• Status Bar – At the bottom of the main program window you will see the Status Bar.  It 
displays various information such as the turn, the current hex coordinates, and the 
characteristics of that hex such as water depth, etc.

You can scroll around the Main Chart by two methods:

• Edge Scrolling – Moving the mouse to the edge of the screen causes the Main Chart to 
scroll in that direction.

• Drag Scrolling – Holding down the left mouse button in the Main Chart and dragging the 
mouse will scroll the chart.

Both of these are enabled by default, but you can turn either of them off by using the Scrolling 
Method option of the Options Menu.  In any case you can use the arrow keys to scroll the Main 
Chart. 

You can zoom in and out in the Main Chart in two ways:

• You can use the scroll wheel on your mouse to zoom in and out.

• You can press the predefined zoom scales 1, 2, 3, and 4 on the keyboard (across the top, not 
the numeric keypad).
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You can also zoom in and out in the Unit List by holding down the Ctrl (Control) key while using 
the scroll wheel on your mouse or pressing the keys 1, 2, 3, and 4 on the keyboard.

The Main Chart displays the Sea and Land hexes associated with the current scenario.  Sea hexes 
can have have up to 5 depth values:

• Very Shallow - Red

• Shallow – Pale Blue

• Medium – Light Blue

• Deep - Blue

• Very Deep – Dark Blue

A Sea hex can also have 3 clutter values:

• Low

• Moderate – Gray rectangle

• Heavy – Black rectangle

The boundary between Sea and Land hexes is shown with a green
line.

The Unit List displays various information associated with
each unit depending on its type.  For seacraft, the values
displayed are:

• Damage – Damage and Staying Power.

• Fuel Used – Fuel Used and Total Fuel (Unlimited for
nuclear power).

• Friction – Accumulated Friction in the battle.

• Max Speed – Maximum speed possible for this ship.

In addition, if a seacraft is the Flagship for its group, then the
Mission is shown in the unit picture.

For aircraft, the values displayed are:

• Number – Number of aircraft in this group.

• Altitude – Current Altitude of this group.

• Friction – Accumulated Friction in the battle.

• Range – The range of this aircraft.

If you right click and hold in the Unit List, then alternate
information is shown:

• Capability – The Capability level of the craft.
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• Signature – The Signature level of the craft.

• Proficiency – The Proficiency level of the unit.

• Size – The physical size of the seacraft.

• Air Capacity – For seacraft, how many aircraft they can carry.

• Home Base – For aircraft, the home air base or ship of the group.

In addition, for aircraft, one of two listings is shown in the alt display:

• For flights, a list of the loads on the aircraft by type and number of each.

• For squadrons, a list of the different capabilities of the aircraft in that squadron.

Alternatively, you can right-click while holding down the Ctrl (Control) key to toggle the display of
alternative information. 

2.1 Counters

Various counters are displayed on the main chart for the entities that are there.

Standard counters are displayed using a color representing the force associated with the 
counter.  A designation on the counter indicates the type of naval group or number and type 
of aircraft in a flight.

Because of Fog-of-War, you may know what force an entity is associated with but not its 
make up.

At the lowest levels of detection, you may not know much more about a detected counter 
other than whether it is a submarine, surface group, or aircraft.

The details as to the exact meaning of these detection levels is described in the Rules 
Documentation.

Other counters and displays on the main chart include:

A SAM site is shown on the main chart using the color of the force which owns the 
SAM.

A Minefield is shown on the main chart using the color of the force which has laid the 
minefield plus a number indicating the density of the mines in that field.

An Air Base is shown using the color of the force that owns it and a runway symbol 
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plus a number indicating the number of aircraft currently at the base.

A Port is shown using the color of the force that owns the port with an anchor symbol.

When a seacraft is sunk or a flight of aircraft shot down, then a marker is placed at the 
location where that happened:

Sunken surface ship.

Sunken submarine.

Crashed flight of aircraft.

2.2 Ranges

Various colored rings are displayed to show ranges in the game.  For loads that an entity might carry
or have, the following color scheme is used:

• Yellow –  Radar range.

• Light Blue – Range of anti-air weaponry.

• Light Green – Range of anti-ship weaponry.

• Dark Blue – Range of anti-sub weaponry.

• Magenta – Range of land-attack weaponry.

• Orange – Range of anti-radiation weaponry.

• Black – The flight range of airborne aircraft.  In addition, for planning purposes, in the Hot 
Spot hex, both the total range and half that range are drawn for the first aircraft selected.

3. Issuing Orders

The core of the Fleet Battle School is based on two key steps:

• Issuing Orders – Each player issues orders to the forces under their control.

• Advancing the Turn – Once all players have issued their orders, the turn is advanced. Note:
in Network Mode (see below), only the Host player can advance the turn.

The process of issuing orders for sea and air units is slightly different but both are based on a three-
step process:

• Press and Hold – A player clicks on the Main Chart at the location of the units they wish to 
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issue orders for.  Note: for air units, an additional selection is required as described below.  
They then hold the mouse button down until order mode is invoked as shown below.

• Drag While Holding -  While holding down the mouse button, the player then drags the 
mouse to indicate the path or direction of the intended movement.  For sea units, this path is 
hex-by-hex.  For air units, the path is in a straight line to the destination hex.

• Release and Specify – Once the path is determined, releasing the mouse button will display 
a dialog so that specific information about the order can be entered.

These steps are described in more detail in the following sections.

3.1 Press and Hold

If there are both sea and air units in the same hex (as when aircraft are being
carried by seacraft), then clicking in a hex will select the sea units.  To issue
orders for the air units in this case, select them individually after clicking in the
hex.  In either case, after holding down the mouse button for a short time, the
game will enter Order Mode and a large red circle will be shown.

3.2 Drag While Holding

With the mouse button held down, the path of the order is specified by dragging the mouse along 
the intended path.  For seacraft, this path is hex-by-hex as shown below.

Optionally, you can release the mouse button in the same hex you started in to specify a Patrol 
order (see below).   For aircraft, the path is a straight line to the destination hex as shown below.
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3.3 Release and Specify

Once the path for the order has been determined, then release the mouse button.  You will be 
prompted for additional information about the order as described below.

In the case of seacraft, the Sea Mission Dialog will be shown.  IMPORTANT: The various elements 
associated with orders in the Fleet Battle School game can be modified on a scenario-by-scenario 
basis.  This means that the specific items you see in the Sea Mission Dialog and Air Mission Dialog 
may vary from the examples shown here.

The Sea Mission Dialog consists of several elements:

• Maneuver – A Patrol is issued when you release the mouse button in the same hex you start 
in.  Otherwise, you will have the option to specify a Transit.

• Operations – The Operations options give you the ability to specify the operations or 
posture the units should have during the execution of this order.

• Speed/Duration – In the case of a Transit, you specify the speed you wish the seacraft to 
move using.  In the case of a Patrol, you specify the duration you wish the seacraft to 
perform that Patrol.

• Risk – You specify a Risk level associated with the order.  The meaning of this level is 
described below.

• Emissions – You specify an Emission level for the seacraft.  The meaning of this is also 
specified in the Rules Documentation.

When you click OK, the order is annotated on the Main Chart as shown below.
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The codes following the Maneuver and Operations of the order reflect the Risk and Emissions 
specified.  Below that is the time span during which the order will be executed.

The Risk value is by default three values:

• Cautious indicates that the group should avoid enemy ships based on the distance to the 
nearest enemy ship.  The exact distances used depend on the type of group and values 
specified in the Rules Documentation.

• Moderate indicates that the group should not make any changes to its specified orders as a 
result of the presence of enemy ships.

• Aggressive indicates that the group should pursue enemy ships based on the distance to the 
nearest enemy ship.  The exact distances used depend on the type of group and values 
specified in the Rules Documentation.

In the case of aircraft, the Air Mission Dialog will be shown.

The Air Mission Dialog consists of several elements:

• Flight – The type of flight for this segment of the overall mission.

• Tasking – The tasking for this mission based on the aircraft capabilities.

• Number – The number of aircraft in this flight.

• Takeoff – The takeoff time of this flight relative to the current time in the scenario.

• Altitude – The altitude to fly this segment of the overall mission.

• Loiter – In the case of a Patrol, the length of time to remain in this Patrol.
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• Interception – The way this flight will conduct Interceptions.  The meaning of these is 
described in the Rules Documentation.

• Options – It is possible to establish options for the order as described below.

Air Mission Options:

• Perpetual – An Air Mission designated as Perpetual will be duplicated each time a flight 
takes off using this order.  The duplicate will be advanced in time by one game turn.  In this 
way, a single order will result in a series of duplicate orders for each game turn after the first
time the order is executed.

When you click OK, the order is annotated on the Main Chart as shown below.

The codes following the Operations and Maneuver indicate the Interception, Number, and Altitude. 
Below that is the time span the order will take to execute.  In addition, if the order is Perpetual, then
the indication “+P” will be shown.

3.4 Adding Additional Orders

In general, you will form a sequence of orders for any unit with each order in turn picking up where
the previous order left off.  To add another order to the ones you have already issued for a unit, click
on the destination of the last order, and then follow the same three-step sequence: Hold, Drag, and 
Release, to create the next order, as shown below.

In the case of seacraft, if you click on the same hex the seacraft is in and issue a new order, then any
previous orders issued for that seacraft are deleted.  Likewise, if you click on any intermediate 
destination in the sequence of existing orders for a unit and create a new order from there, then any 
orders beyond that intermediate destination are deleted.

In the case of aircraft, if you click on the same hex as the aircraft is in and issue a new order, then it 
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creates a new order for another flight from that same unit.  If you want to delete an existing order 
for an aircraft unit, see the section below on Editing Orders.

3.5 Air Mission Orders

While you issue a single sequence of orders for ships, aircraft missions are handled differently.  An 
aircraft unit on the surface normally represents a squadron of aircraft from which you can issue 
multiple missions.  Each mission will consist of a flight of aircraft from the squadron, the number of
which is specified when you first create an order starting at that squadron.  Typically, an air mission 
for a flight of aircraft will start with a Fly To order which causes the flight to take off and fly to a 
specific point.  From there, you may likely issue a Patrol order which will cause the flight to fly 
back and forth in the Patrol path for the duration you specify in the order.  Alternatively, you may 
specify an Attack order which causes the flight to attack a specific target on the surface relative to 
its stated mission.  In the case of air missions involving Air Superiority or Anti-Ship missions, the 
AI of the program will cause the flight to automatically intercept appropriate enemy targets as they 
appear.  All missions end with a Return to Base which is automatically created when the flight 
completes its mission either by Patrol time or by Attacking a target and becoming "mission 
winchester".  You can issue a manual Land order if you wish, but this is not required.

You can issue multiple orders for a single squadron with each order creating a new flight.  As you 
do so, the Unit List display is updated next to the number of aircraft  in that flight with the number 
of aircraft committed to missions a the current time.  This display can help you keep track of how 
many aircraft have been given orders.  Note however that in general you do not want to commit all 
of your aircraft at one time but rather schedule their missions over the duration of the operation.  To 
see the full allocation of your aircraft over a 24 hour period, see Air Allocation below.

3.6 Editing Orders

You can change orders you have previously issued by double-clicking in the hex containing the 
selected units.  You will be prompted with the same Sea Mission Dialog and Air Mission Dialog as 
before to make changes to that particular order.  In the case of the last order issued, you will also 
have the option to delete that order.  In addition, as mentioned before in the section on Adding 
Additional Orders, you can delete existing orders by issuing a new order either from an intermediate
destination or, in the case of seacraft, by issuing a new order from the starting point of the seacraft.

3.7 Altitude Values

Depending on the type of aircraft, specifying a flight altitude for an order determines a specific 
altitude in feet for that order.  The table below gives representative examples although the specific 
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values depend on the Rules File.

Altitude in Feet High-Altitude
Jet Aircraft

Standard Jet
Aircraft

Propeller
Aircraft

Helicopters

VHigh (60,000 ft) Cruise Flight

High (30,000 ft) Low Flight Cruise Flight

HMed (20,000 ft) Cruise Flight

LMed (8,000 ft) Cruise Flight

Low (2,000 ft) Low Flight Low Flight

VLow (200 ft) Low Flight

3.8 Aircraft Turn Around

When a flight of aircraft returns to base, it has to be turned 
around before it is ready for tasking.  During this time, the 
image of the flight shows “Turn Around” in the Unit List.  By 
default, the flight will be available for one game turn at which
point it will rejoin the squadron and be available for 
additional tasking.

3.9 Helicopter Rules

While helicopters fall under the classification of aircraft and can be assigned orders like standard 
aircraft, there are special rules that apply to helicopters different from the rules that apply to fixed-
wing aircraft.

A helicopter can be given a patrol in a single hex, called a Hover Patrol, while fixed wing aircraft 
must fly a path in a patrol, a Circuit Patrol.  While in a Hover Patrol, special rules apply to 
helicopters while performing ASW (Anti-Submarine Warfare).  ASW must be flown using Low 
Flight but when conducted during a Hover Patrol, helicopters follow the same rules as ships for 
detecting and engaging submarines.  That is, they are capable of detecting submarines using the 
active sonar encounter rules.  Likewise, they can engage detected submarines using on-board Anti-
Sub ordnance.  The detection and engagement of submarines by helicopters during ASW is handled 
automatically by the internal rules but is also part of Umpire Mode (see below) when invoked.

In addition, when a helicopter is in Hover Patrol within a certain distance from its home ship, it will
maintain its distance and direction from the home ship as the home ship transits.  The maximum 
distance the helicopter can depends on its flight altitude:

• When a helicopter flies in Low Flight as in performing ASW, it must be within 1 hex of its 
home ship to perform Station Keeping.

• Otherwise, when a helicopter is flying at Cruise Flight, it must be within 100 nm of its home
ship (This value is part of the Rules File and can vary by scenario).  This will typically 

10



translate into 4 hexes but can vary by the scale of the Rules File.

The reason for this limitation is due to the helicopter needing to maintain a line-of-sight with its 
home ship.

To issue a Hover Patrol order with bearing and distance maintained, you should:

• First order a Fly To order for the helicopter to the hover location.

• From there, issue a Patrol order for a certain duration.

The helicopter will depart its home ship, fly to the hover location, and from that point, maintain 
bearing and distance from its home ship.

3.10 Air Allocation

As mentioned previously, in general you want to space out your air missions over a 24 hour period 
during the operation so that you have sufficient coverage for defensive and offensive air missions.  
To build a plan for air allocation and see how you are matching up to that plan, you use the Air 
Allocation feature.  If you select the Air Allocation option from the Scenario Menu, it will display 
the Air Allocation Dialog relative to the air squadrons in the currently selected hot spot as shown in 
the screenshot below.

The Air Allocaton Dialog divides up the 24 hour period into game turns.  Associated with each turn 
there are two values: The number of aircraft you have allocated during that turn and the number of 
aircraft you have tasked for a mission in that turn.  The Total at the end of the rows is the total 
number of aircraft allocation while the Totals at the bottom of each column are the number of 
aircraft allocated for that turn and the number of aircraft tasked for that turn.

You use the Allocation Dialog as a planning tool.  Start by allocating your aircraft over the 24 hour 
turn according to your plan on how you want to use them taking into account expected attribution 
and required aircraft turn around.  Next build your air mission plan based on orders and takeoff 
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times.  As you do so, compare your tasking with the plan you build using allocation to see if your 
air orders are following the plan you established for the next 24 hour period.

3.11 Underway Replenishment

It is possible to replenish your ships during a scenario provided you have an AO or AOE oiler 
available.  The requirements for replenishment are then as follows:

• The ships you want to replenish should be in the same has as the oiler.

• If the ships have any order assigned to them, it must be the Replenishment mission.

• If the ships are transiting, they must not exceed the speed given by the Rules File (typically 
16 knots).

Provided these conditions are met, then your ships will automatically be replenished as the scenario 
progresses.

3.12 Electronic Attack

Certain aircraft are designated as Electronic Attack aircraft with the notation EA.  Such aircraft 
provide some defense against enemy missiles when they are flying in the same hex as the target 
aircraft.  The Effectiveness of the EA aircraft capability versus the missile capability is used to 
determine a probability.  This then determines a defense value of 1 minus that probability.  This 
defense value is multiplied times the Effectiveness of the missile attack against the target aircraft 
resulting in the final probability that is used to resolve the attack.

4. Running the Game

You advance the turn in a game by selecting the Advance Turn option of the Scenario menu.  By 
default, the main program runs at about 100 times real-time so that a 3 hour turn is completed in 2 
minutes.  By the use of the Hot Keys below, it is possible to speed execution up to the point where a
3 hour turn is completed in 12 sec and a 24 hour period can be executed in 96 seconds.  In addition, 
there is a Jump Mode which is the fastest possible execution described in the next section.

Name Real Time 3 Hour Turn 24 Hour Period Hot Key

Default 100x 2 min 16 min F5

2x Default 200x 1 min 8 min F6

5x Default 500x 24 sec 3 min 12 sec F7

10x Default 1000x 12 sec 96 sec F8

Jump Mode ------ ------ ------ F9

During execution, a player (or Host in network play) can pause the game by pressing the Space 
Bar.  Pressing the Space Bar again will resume execution.
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Note: scenarios that consist of seacraft only are easily played at 10x mode (F8) while those 
involving aircraft are normally played at a slower speed.

4.1 Display Mode

Fleet Battle School is a hex-based game and internal calculations are all done relative to the hex 
geometry of the chart and hex position of the entities.  In Discrete Mode entities on the main chart 
are displayed using their internal hex coordinates.  In a variant of that called Continuous Mode, the 
position of entities on the main chart is shown using smooth interpolation so that they move 
continuously from hex to hex rather than in steps.  You toggle between Discrete Mode and 
Continuous Mode using the Hot Key C (Capital C) or by using the Display Mode option of the 
Options Menu.

Further, there is a Jump Mode that can be invoked with the Hot Key F9 or by using the Display 
Mode option of the Options Menu.  In Jump Mode, the entire turn execution is done prior to 
updating the display and thus represents the fastest possible way to execute a turn.

Note that all of the Display Modes are only visual effects and the setting has no effect on the 
internal calculations of the game engine.

4.2 Hit Detail

Hits against ships, aircraft, and other targets is shown at the top of the main chart.

You can click on any of the descriptions and the main chart will scroll to the location that hit 
occured.

5. Network Games

You can establish a Fleet Battle School network game in multiple ways:

• You can connect both mobile and desktop systems to a desktop system which is designated 
as the Host.

• You can connect both mobile and desktop systems to a stand-alone system on the Internet 
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which acts as the Server for the game.

Note that the port that Fleet Battle School uses for network games is 9253 and this must be 
available to the software to open without blocking from firewalls or other protective software such 
as anti-virus.

In the desktop version of Fleet Battle School, you do this in one of two ways:

• One of the desktop systems should select Server option from the Mode menu.  This will 
establish that system as the Host and all other systems, desktop and mobile, should then 
connect to that system.

• All other desktop systems connect to the Host using the Caller option from the Mode menu.
This will allow that system to connect to the Host system for network play.

There is a slight difference between being a Host or being a Server.  A given network game needs 
both a Host and a Server with a desktop system being able to act as both of these using the Server 
option.  When using a stand-along system on the Internet which acts as the Server, then one of the 
systems that connects to it as Callers will still be a Host but not a Server.

The Host in a network game is responsible for loading and saving the scenario being played.  All 
other connections, both desktop and mobile, will be sent a copy of the scenario.  Likewise, the Host 
computer (or Server if stand-alone)  is responsible for managing the network traffic and ensuring 
syncronization of all Callers.

Host Mode

When you establish your computer as the Server, you will also be the Host.  The program will 
prompt you to enter your Player name for the game.

Your IP address is then displayed so you can convey that information to other players wishing to 
connect to you.
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Caller Mode

When you invoke the Caller option of the Mode menu, you will be prompted to enter the IP address 
or hostname of the Server.

Likewise, you will be prompted to enter your player name for the game.

5.1 Summary of Network Play Terminology

The following terms are used when talking about a network game configuration.

• Server – A Server can either be an instance of FBS invoked in Server mode or the stand-
alone server program.  All Callers in a network game are connected to a Server.

• Caller – A Caller is any instance of FBS which is invoked in Caller mode and thus 
connected to a Server.

• Host – An instance of FBS which has initiated a network game.  The Host is responsible for 
loading and saving games in network play.  A Host will be a Server or Caller and will be an 
Umpire or Commander.

• Umpire – An instance of FBS which is a Host but which is not playing a specific side.  An 
Umpire is responsible for resolving the adjudication of the network game for all other 
players.

• Commander – The first instance of FBS to join a network game on a given side will be the 
Commander for that side.  A Commander is responsible for assigning organizations to all 
Callers on that side.

6. Umpire Mode

This section describes the various features associated with Umpire Mode in network play.  You 
select Umpire Mode when prompted by the Player Side Dialog which is displayed when you start 
Server Mode.
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There are several features associated with Umpire Mode:

• There is no Fog-of-War in Umpire Mode.  The Umpire can see the units and orders of both 
sides.

• The Umpire is prompted for Encounters and Engagements and given the option of 
modifying those before they are applied in the game as described below.

• If all the players in the network game have joined on the same side, then the Umpire has the 
option of playing the opposing side.  Otherwise, the Umpire's interaction is limited to the 
Encounter and Engagement feature.

6.1 Encounter Prompts

When a possible Encounter occurs in the game, execution is stopped and the Umpire is prompted 
with the Encounter Dialog.  The Encounter Dialog has several elements:

• Source/From – The unit or group that can generate the Encounter and its location.

• Target/To – The unit or group that can be the target of the Encounter and its location.

• Percentage – Based on internal tables and modifiers, the probability that the Encounter will 
occur.

• Encounter/Detection – The type of Encounter that has occurred (Visual, Radar, Sonar, …) 
and the Detection level as determined by the game engine using a random number 
generation against the percentage.

  

The Encounter and Detection fields for each entry are editable by the Umpire.  Doing this involves:

• Clicking in the field to be changed.

• Selecting one of the drop-down options shown.

• IMPORTANT: Click again, or hit return, to enter the selected value into the field.

6.2 Engagement Prompts

Once the possible Encounters have been determined, then Engagements are resolved.  The Umpire 
is prompted with a list of these for review in the Umpire Engagement Dialog.
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In addition to the fields before the Damage field shows how much damage has occurred to the 
Target as determined by the internal tables and modifiers of the game engine.  This value can be 
edited by the Umpire as before:

• Clicking in the field to be changed.

• Entering a new damage value.

• IMPORTANT: Click again, or hit return, to enter the selected value into the field.
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